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TRANSITION TO WINDOWS 10 / NEW JENOPTIK CAMERAS
Microsoft discontinued support of Windows 7 on January 14, 2020.  As of 2020, BIOQUANT requires 
Windows 10 64-bit.

AS OF 2020: BIOQUANT OSTEO NO LONGER SUPPORTS WINDOWS 7

As of 2020, BIOQUANT OSTEO  no longer supports Windows 7.  Microsoft discontinued support of 
Windows 7 on January 14, 2020. BIOQUANT OSTEO 2021 requires Windows 10 64-bit. 

UPDATED COMPUTER REQUIREMENTS
When upgrading to BIOQUANT OSTEO 2021, consider whether your computer should be updated. 
Although older computers might run BIOQUANT OSTEO 2021, those that don’t meet current 
specifications will be slower, especially when considering core clock speed.

Here are the current computer requirements and recommendations:

OPERATING SYSTEM REQUIREMENTS
•	 Windows 10 64bit Pro, Education, or Enterprise. (Windows 8, Windows 7, Windows 

XP, Mac OS not supported.)

MINIMUM COMPUTER SPECIFICATIONS
•	 Dell Precision Series Mini-Tower Chassis

•	 Multi-core Intel Processor: I7 processor or better

•	 3.5 GHz core clock speed

•	 NVIDIA Quadro K620 GPU or better

•	 16 GB RAM

•	 Chassis with room for 1/2 height & 1/2 length PCIe 1X board

•	 Monitor that supports a 1920x1200 desktop resolution

RECOMMENDED COMPUTER SPECIFICATIONS
•	 Dell Precision 5000 Series Mini-tower Chassis

•	 Multi-core Intel Processor: Xeon processor

•	 4.0 GHz or higher core clock speed

•	 NVIDIA Quadro P1000 GPU or better

•	 32 GB RAM or more

•	 Chassis with room for 1/2 height & 1/2 length PCIe 1X board

•	 Monitor that supports a 1920x1200 desktop resolution 
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LEGACY QIMAGING CAMERA SUPPORT
QImaging does not support their FireWire cameras under Windows 10.

BIOQUANT will make every effort to support legacy QIMAGING cameras with the current BIOQUANT 
OSTEO 2021 release. However, please be aware that our capacity to help is limited due to those 
outside constraints. 

For the long-term stability of your system, we encourage you to consider upgrading to one of the 
recommended Jenoptik Gryphax cameras listed below.

JENOPTIK NEXT-GENERATION SCMOS CAMERA SUPPORT

NEW JENOPTIK CAMERA SUPPORT

 JENOPTIK GRYPHAX® CAMERAS

We are excited to announce support for the biggest camera technology upgrade since the 
introduction of the first high resolution digital cameras.

BIOQUANT now supports the PROKYON, KAPELLA, and SUBRA cameras from Jenoptik.

These Jenoptik cameras all use a next generation scientific CMOS sensor that eliminate the 
compromises inherent in all the prior CCD sensor cameras.

These cameras can deliver a full 1920x1200 resolution image at between 30 and 60 frames per 
second. This is 2X to 4X faster than current cameras at 4X the resolution. 

In BIOQUANT, supported Jenoptik cameras provide a live image at 1280x960 to the Image Window 
with optional 1920x1200 image capture. The PROKYON camera model adds additional capture sizes 
of 3840 x 2400 and 5760 x 3600.
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THREE AVAILABLE MODELS TO FIT ANY BUDGET

The flagship Prokyon model offers a special 20 megapixel mode through pixel-shifting in addition to 
the native live image at 1920x1200 60 fps with fan-less cooling. The Kapella camera keeps the fan-
less cooling but saves money by removing the 20 megapixel imaging mode. The Subra model is even 
more economical than the Kapella by removing the fan-less cooling.

Contact us for Pricing and Upgrade Discounts. 

LIMITED TIME CAMERA TRADE-IN DISCOUNT PROMOTION

BIOQUANT and Jenoptik offer a trade-in discount for QIMAGING cameras toward the purchase 
of a new Jenoptik camera. Every QIMAGING camera sold with a BIOQUANT system, and many 
others, qualifies for this trade-in discount promotion. Discount amounts range from $690 to $1990 
depending on the Jenoptik camera model purchased. Please act quickly, this is a limited time 
promotion.
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MAJOR NEW FEATURES

BIOQUANT OSTEO: NEW EXPANDED OME-TIF SUPPORT

BIOQUANT has expanded support for multi-dimensional image data from confocal and light sheet 
microscopes. BIOQUANT 2021 now supports both single file and multiple file OME-TIFs. 

ABOUT CONFOCAL AND LIGHT SHEET DATA

New optical clearing techniques for in-tact bone have made the use of confocal microscopy possible 
in previously inaccessible bone samples. Labs are now leveraging confocal microscopy in bone to 
explore solutions to previously intractable questions.

Simultaneously, a new generation of microscope systems called Light sheet microscopes are starting 
to collect enormous image data sets of entire bones with multiple fluorescent labels and multiple Z 
depths at sub-micron resolutions.

5D IMAGE NAVIGATOR - CORTICAL BONE INNERVATION.OME.TIF*

A high magnification view of a cortical bone cross-section showing 
nerve distribution along the periostium and across the cortical bone.  

Composite image of 5 Z planes and 3 different fluorescent labels.

* CORTICAL BONE INNERVATION.OME.TIF

Multi-channel Confocal Stack of Cortical Bone Innervation by Erica Scheller and Washington 
University in St. Louis (https://sites.wustl.edu/schellerlab/) is licensed under CC BY 4.0. To view 
a copy of this license, visit https://creativecommons.org/licenses/by/4.0.



Page 7 • 21.5.6

THE DETAILS OF 5D IMAGING

NEED AN INTRODUCTION TO 5D IMAGING?

Watch the “Introduction to 5D Imaging Video.” In the Image region, click the > button 
to open the Tutorial Videos.

5D imaging is a strategy for organizing images of fluorescent samples. The 5 dimensions we’re talking 
about are x width, y height, c fluorescent channel, z focal plane, and t time point.

The simplest images is an area of a sample with a single fluorescent label at a single focal plane at a 
particular time. As you add more fluorescent channels, add more Z planes, and add more time points, 
the number of dimensions expands from 2 to 5. The following series of diagrams helps to explain.

DETAILS OF 5D IMAGING: A 2D IMAGE

A single fluorescent label at a single focal point at a particular time creates a 2D image.

DETAILS OF 5D IMAGING: A 3D IMAGE

Three fluorescent labels at a single focal point at a particular time create a 3D image.
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DETAILS OF 5D IMAGING: A 4D IMAGE

Three fluorescent label at a five focal points at a particular time creates a 4D image.

DETAILS OF 5D IMAGING: A 5D IMAGE

Three fluorescent label at a five focal points at 3 distinct time points creates a 5D image.

Confocal and light sheet microscopes can collect many images of a sample each representing 
different combinations of XYCZ, and T. These images can easily reach multiple gigabytes in size.

To simplify moving all that data around, a few different solutions have emerged.

•	 Confocal and light sheet companies made their own proprietary file formats.

•	 ImageJ created Hyperstacks using the TIF format. Hyperstacks are a way to store 5D data 
in TIF files. 

Missing from ImageJ’s approach was a more complete way to store the necessary information 
describing all the various images in the file. So the folks at the Open Microscopy Environment 
project created OME-TIF.

•	 OME-TIF uses the basic idea of storing multiple images in a single TIF file, but adds a 
formal framework for storing all the necessary information about those images in the 
same TIF file. This information is called metadata.

The BIOQUANT 5D Image Navigator supports the OME-TIF format.

We chose this format because the Open Microscopy Environment project also made a free 
ImageJ plugin called BIO-FORMATS which can convert just about every other 5D format into 
OME-TIF. That allows BIOQUANT to support the broadest array of 5D data.
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BIOQUANT OSTEO EXPANDED SUPPORT FOR THE OME-TIF FORMAT

BIOQUANT OSTEO now supports both single file and multiple file OME-TIFs. The previous version of 
BIOQUANT only supported single file OME-TIFs.

CONVERT TO SINGLE FILE OME-TIF

To create a single file OME-TIF, use the BIO-FORMATS exporter in Image J to convert the image 
file(s) from your light sheet or confocal microscope to an single OME-TIF by NOT checking each of 
the three “write to separate file” check boxes. 

Currently BIOQUANT can open OME-TIF files up to 4 GB. For a video, see “5D Image Navigator: 
Converting to the OME-TIF Format” below.

CONVERT TO MULTIPLE FILE OME-TIF

To create a multiple file OME-TIF, use the BIO-FORMATS exporter in Image J to convert the image 
file(s) from your light sheet or confocal microscope to an OME-TIF sequence by checking each of the 
three “write to separate file” check boxes. 

Currently BIOQUANT can open OME-TIF sequences where the total size of all images is less than 4 
GB.        

OPENING AN OME-TIF FILE/FILE SET

Multi-dimensional image data in the OME-TIF format is loaded into the 5D Navigator using with one 
of the following options:

•	 In the Image region, from the Sequence menu, choose “Open OME TIF File to 5D Image 
Navigator” menu item to open a single OME-TIF file. 

•	 In the Image region, from the Sequence menu, choose “Open OME TIF Sequence to 5D 
Image Navigator” menu item to open a single OME-TIF file.       

5D NAVIGATOR VIDEOS AVAILABLE

To access the videos, in the Image region, click the > Video Help button. 

5D IMAGE NAVIGATOR: CONVERTING TO THE OME-TIF FORMAT

This video covers converting your confocal or light sheet image series to the OME-TIF format 
using the BIO-FORMATS exporter in Image J. 

5D IMAGE NAVIGATOR: INTRODUCTION AND OPENING AN OME-TIF FILE

This video covers opening the OME-TIF file/sequence into the 5D Image Navigator.

5D IMAGE NAVIGATOR: MEASUREMENT OVERVIEW

This video walks you through a sample measurement protocol using the 5D Image Navigator. 
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BIOQUANT OSTEO: NEW REDRAW / OVERVIEW SUPPORT FOR Z OFFSET

The following new Redraw menu items and Overview window menus make it easier to navigate 5D 
image data by only showing the measurement tracings for the current Z position. The current Z 
position is shown in the Parameters region, in the Z Offset field. 

This feature can also be used to redraw at different Z positions in physical sections, as well as to 
redraw at different Z Positions in the Dicom Navigator.

NEW REDRAW MENU ITEMS FOR Z OFFSET

BEFORE AND AFTER REDRAW CURRENT Z OFFSET

Top: all tracings appear. Bottom: only the tracings from the current Z position appear.

•	 Topography> Assign System Redraw> All at Current Z Offset

Assigns the Image region Redraw button to redraw all the measurement tracings at the current 
Z Offset in the Parameters region that were measured into the current Topo array. The current 
Z Offset and current Topo Array are designated in the Parameters region.

If Topography> Assign System Redraw> Clear All + Redraw is also checked, then existing 
thresholds and tracings are cleared before the measurement tracings located at the current Z 
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position are displayed. This option is checked by default.

This feature is useful when navigating through the Z Planes of a confocal or light sheet image 
set loaded into the 5D Image Navigator because it keeps measurement tracings from other Z 
positions from overlapping the measurements tracings of the current Z position. Likewise, this 
feature also supports navigating through the Z Offset of physical serial sections and navigating 
through Z Positions in the Dicom Navigator.

•	 Topography> Redraw> All at Current Z Offset

The Topography> Redraw> All at Current Z Offset menu item redraws measurement tracings at 
the current Z Offset for all sections in the current Topo array. The current Z Offset and current 
Topo Array are designated in the Parameters region. It does not clear away other tracings first. 
(For this capability, use the Topography> Assign System Redraw>All at Current Z Offset menu 
above.)

This command is useful when you want to redraw the tracings measured at the current Z Offset 
on an image without clearing its threshold or other tracings.

NEW OVERVIEW MENU ITEM FOR Z OFFSET

•	 Overview Window> Options Menu> Redraw Current Z Offset

When this option is on, the Overview window displays only the measurement tracings located 
at the current Z offset on the Parameters region. If this option is off, then all the tracings are 
displayed in the Overview window.

This feature is useful when navigating through the Z Planes of a confocal or light sheet image 
set loaded into the 5D Image Navigator because it keeps measurement tracings from other Z 
positions from overlapping the measurements tracings of the current Z position. Likewise, this 
feature also supports navigating through the Z Offset of physical serial sections, as well as Z 
Positions in the Dicom Navigator.

BIOQUANT SCAN: SCAN MULTIPLE AREAS & SKIP EMPTY FIELDS

A new method, “Scan by Topo” has been introduced. It allows for quickly defining multiple scan areas 
using area tracings made at low magnification.

SCAN BY TOPO: SCAN MULTIPLE SECTIONS FASTER 

This method allows scan areas to be quickly marked out using the lowest power objective on the 
microscope, then automatically scanned with you preferred imaging objective, usually 20X or 40X.

Up to 8 different scan areas can be scanned in one session.

This also means that BIOQUANT SCAN now skips all fields of view that are not in the scan area, 
significantly speeding up scan times. Previously, BIOQUANT SCAN collected an image of each field of 
view in a rectangle that contained the scan area. Since tissue sections are rarely rectangular, a lot of 
those fields of view were blank.
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SCAN BY TOPO: A TECHNICAL EXPLANATION

BIOQUANT SCAN uses the first 8 area tracings stored in a topo array. Topo arrays are the D# arrays 
that store all the measurement tracings in BIOQUANT. These tracings are stored automatically when 
the Measure button is pushed in the Measurement region.

A new data set template, called the “Scan Areas Template” has been added. It has a Topo array and an 
Area array. The area array is used with the Manual measurement type to define the scan areas. The 
topo array is read by BIOQUANT SCAN to control the scanning algorithm.

THE SETUP BOX FOR THE NEW SCAN MODE: SET BY TOPO

Note the 5 scan areas identified in the preview graphic. The green arrow points to 
the “You are Here” box. The light blue arrows point to corresponding tracings and 

scan areas. Up to 8 areas can be marked across as many as 4 different slides. The scan 
graphic shows the proportional size and shape of the images that will be generated.

QUICK PROTOCOL FOR SCAN BY TOPO: DEFINING SCAN AREAS

1.	 Put up to 4 slides on the stage.

The 4 slide holder fits 4 75x25mm slides vertically. The rotating slide holder holds 2 75x25 
slides in any orientation.

2.	 Create a data set using the new “Scan Areas Template” data set.
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3.	 Activate the stage and camera.

4.	 Select the lowest power objective on the microscope.

5.	 Adjust the exposure time and white balance.

We’ll configure background correction on the high power objective, after the scan areas have 
been defined.

6.	 Using the Manual measurement type, with “Live Manual Measure” and “Spacebar to 
End” turned on, trace the first scan area across as many fields of view as needed. When 
you get close to the start of the tracing, tap the space bar to close it.

If the first scan area is larger than a field of view, use the M key on the keyboard or the joystick 
to move the stage. The M key is faster: You tap the M key, then click near the end of the tracing, 
then click where you want the tracing to move, and the stage will move. The M key is faster as 
you do not have to take your hand off the mouse and the system automatically redraws after 
moving.

7.	 After the first scan area is traced move to the next scan area and repeat.

The Overview window will show a map of your current position and the scan areas that you’ve 
defined so far.

QUICK PROTOCOL FOR SCAN BY TOPO: SCANNING

1.	 Once the scan areas are defined, switch to the objective you want to use for scanning.

2.	 Move to a blank part of the slide, adjust the exposure, white balance, and enable 
background correction.

3.	 From the Scan menu, choose Scan Multiple Slides.

4.	 On the Scan Multiple Slides box, type in a project name and then click Setup.

5.	 On the Scan Multiple Slides Setup box, from the Set By drop list, choose “Topo Arrays”

6.	 Enter the prefix for the image file names.

The BIF files created by the scan will be named [prefix]01Montage.bif, [prefix]02Montage.bif, 
etc.

7.	 Click the Set button to read in the scan areas from the topo array.

There’s a drop list that shows the topo arrays in the dataset. The scan template only has 
one topo array, so there’s nothing to choose but you could make a custom template that has 
multiple topo arrays.

For example, you could make a data set that has one topo array for each group of slides scanned. 
Then you’d have a permanent record of the scan areas and could rescan anything you needed 
quickly.

8.	 Make any adjustments you want to the auto focus.
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9.	 Choose white or black to fill in the empty fields of view.

10.	 Click OK to close the Setup box.

11.	 Click Start to begin scanning.

You can always click the Pause and Back buttons to have the system back up and rescan a 
region.

12.	 A message box will let you know when the scans are done.

The “You are Here” box in the Overview window acts as a progress indicator showing you where 
the system is relative to all the defined scan area.

BIOQUANT SCAN: CONTROL FOR COOLLED FLUORESCENCE ILLUMINATOR

BIOQUANT SCAN can now control the CoolLED pE-300 White fluorescence light source.

The pE-300 is a multi-channel LED fluorescence excitation light source. Since it is an LED light 
source, it has an extremely long life. Since it a multi-channel light source, the excitation strength of 
each fluorochrome can be adjusted individually.

This means that when working with multi-label mineralizing surfaces, you can turn down the 
brightness of the calcein label and turn up the brightness of the alizarine red label at the light 
source. This helps preserve the sample and simplifies camera settings. There no need now to use 
camera settings to adjust the relative brightness of labels in the image.

THE COOLLED PE-300 WHITE FLUORESCENCE ILLUMINATOR

The brightness of each fluorochrome (red, green, blue) can be adjusted 
in the light source. This significantly simplifies imaging.
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COOLLED SETUP BOX

The excitation brightness for each fluorochrome is adjustable. Each fluorochrome 
can be turned on and off individually. All the light can be turned on and off.

QUICK PROTOCOL FOR COOLLED SETUP

1.	 From the Scan menu choose, CoolLED Setup.

2.	 Move the sliders to adjust the brightness of the excitation for each fluorochrome.

3.	 Alternatively, use the remote control pod to make comparable adjustments.

MAJOR ENHANCEMENTS

BIOQUANT OSTEO: MOTORIZED STAGE “M” TOOLBAR ENHANCEMENTS

The following enhancements have been made to the Motorized Stage “M” toolbar.

ENHANCEMENT: MOTORIZED STAGE TOOLBAR IS LARGER

The Motorized Stage “M” Toolbar is larger, making the icons easier to click.

M TOOLBAR

Icons are now larger.

To open the “M” Toolbar, you need a supported motorized stage.

From the Topography menu, choose “Open Motorized Stage Toolbar...” to open the toolbar.
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ENHANCEMENT: COARSE / FINE MOVE STAGE NOW REDRAWS TOPO

The Coarse Move, Fine Move, and “Move Stage by Clicking Two Points” tools (the first 9 buttons) on 
the M Toolbar now automatically redraw the Topo data after the stage finishes moving.

The Stereology move  tools (last four icons) already redraw the stereology grid and dissection.

BIOQUANT SCAN: BACKGROUND CORRECTION INDICATOR ENHANCEMENT

The following enhancements have been made to the BIOQUANT SCAN add-on.

BACKGROUND CORRECTION INDICATOR ENHANCEMENT

For bright field scans, the Scan Multiple Slides and Scan Well Plate boxes now have a Background 
Correction indicator that reminds you to save a background image and turn on Activate Capture 
Correction on the Background box.

BACKGROUND CORRECTION INDICATOR

Background correction is necessary for a seamless bright field scan. It 
removes subtle uneven lighting from each field of view. If you’ll be collecting 

density data, contact technical services to discuss the details.
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BACKGROUND CORRECTION FIXES THE UNEVEN LIGHTING CHECKERBOARD

The image on the top shows the checkerboard pattern (light blue arrows) 
that’s created by uneven lighting in individual fields of view. 

The image on the bottom shows what a properly corrected scan should look like.

EXCEPTIONS - WHEN BACKGROUND CORRECTION SHOULD BE OFF

The indicator is for bright field scanning only. Fluorescent scans do not use Background Correction. If 
you are capturing fluorescent scan, the indicator should read BACKGROUND CORRECTION: OFF in 
red. 

In addition, if you are measuring Integrated Optical Density, the indicator should read 
BACKGROUND CORRECTION: OFF in red. Integrated Optical Density does use the background in 
its calculation, and a background image should be saved. However, Enable Capture Correction must 
be off. You will not be able to correct for uneven lighting in your SCAN. 

UPDATED DOCUMENTATION

All BIOQUANT Scan Protocols have been revised and updated in the BIOQUANT OSTEO Manual. 
Review updated protocols to ensure that your system has been optimized for camera and lighting.
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MINOR ENHANCEMENTS / ISSUE RESOLUTIONS
The following minor enhancements and issue resolutions have been made to the software.

BIOQUANT OSTEO: MINOR CHANGES

1.	 Enhancement: The 5D Navigator and Image Navigator Setup box no longer shares fields.

Previously, the 5D Navigator and Image Navigator Setup box shared the following fields:

•	 Coarse Move Step (% of Pan Box)

•	 Fine Move Step (% of Pan Box)

•	 Coarse Move Step (Cells / Fibers)

•	 Pan Box/Cross Color

Now, these fields are unique. If you change them in the 5D Navigator Setup box, they no longer 
also change in the Image Navigator Setup box.

2.	 Enhancement: The Option>Reset Parameters menu resets Redraw Current Z Offset 
options

When you click Reset Parameters on the Options menu, the system is reset to default 
parameters. The following features associated with redrawing the current Z Offset are now 
reset:

•	 Topography>Assign System Redraw>Current Topo Array resets to checked.

In effect, this also unchecks Topography>Assign System Redraw>All at Current Z Offset.

•	 On the Overview window, the Options>Redraw Current Z Offset resets to unchecked.

3.	 Issue Resolution: The Installation Program did not allow numbers or symbols as the first 
character in the First Name, Last Name, Position, or Institution fields.

There have been several user facilities that have numbers as the first character in their name.

Previously, the First Name, Last Name, Position, and Institution fields were required to contain 
text that began with a letter. 

This issue has been resolved.

4.	 Issue Resolution: Measuring IO Density with background from unsaved image from the 
Jenoptik Camera now supported.

Previously the system would allow Jenoptik Camera users to save a background with capture 
correction disabled on an unsaved image. However, when attempting to measure IO Density, a 
message would open that stated, “A Background image is required for IOD Measurement.” This 
has been resolved.

Previously this protocol worked with QImaging Cameras. It also worked saved images from 
Jenoptik cameras.
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5.	 Issue Resolution: Multi-Band Threshold: RGB values on Threshold region now update 
when View next to Band is clicked

On Multi-Band Threshold, next to each Band is a “View” button.

When you click the “View button” the threshold graphic overlay in the Image window updates 
to match that band.

However, the RGB values on the Threshold region did not update to match the graphic overlay 
in the Image window. 

This has been resolved.

6.	 Issue Resolution: Multi-Band Threshold: After the New button is clicked, the MBT File 
field is cleared.

Previously, on Multi-Band Threshold, when the New button is clicked, the MBT File field would 
still display the prior loaded MBT File name, even though it was no longer open. Now, when the 
New button is clicked, the MBT File field is empty.

BIOQUANT SCAN: MINOR CHANGES

1.	 Enhancement: Scan Multiple Slides - Set by Center - Set 1 button no longer updates other 
center values.

On the Scan Multiple Slides box, the Set 1 button under the first slide no longer automatically 
sets the positions of the other slides.

Previously, when the Set 1 button was clicked, it would increment the center X value 
accordingly and set the centers of the other slides. If the scan centers were set from right to left, 
then this would overwrite the previous scan centers.


	BIOQUANT OSTEO 21.5.6 Release Notes Cover Page
	Contents
	Transition to Windows 10 / New Jenoptik Cameras
	As of 2020: BIOQUANT OSTEO no longer supports Windows 7
	Updated Computer Requirements
	Legacy QImaging Camera Support
	JENOPTIK Next-generation sCMOS Camera Support

	Major New Features
	BIOQUANT OSTEO: New Expanded OME-TIF Support
	BIOQUANT OSTEO: New Redraw / Overview Support for Z Offset
	BIOQUANT SCAN: Scan Multiple Areas & Skip Empty Fields
	BIOQUANT SCAN: Control for CoolLED Fluorescence Illuminator

	Major Enhancements
	BIOQUANT OSTEO: Motorized Stage “M” Toolbar Enhancements
	BIOQUANT SCAN: Background Correction Indicator Enhancement

	Minor Enhancements / Issue Resolutions
	BIOQUANT OSTEO: Minor Changes
	BIOQUANT SCAN: Minor Changes

	Blank Page

